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How to Use: 
 

 

 

 
 

 

Microsoft Publisher 2007 
 

 

 

 

Microsoft Publisher is a desktop publishing application which allows you to create artistic documents such as 

brochures, flyers, and newsletters.  Many of the commands and toolbars in Publisher are similar to other 

Microsoft Office applications, so new users will find text editing familiar.  However, Publisher is much more 

flexible, in that text, graphics and even tables are all independent elements.  It is the precise maneuvering and 

positioning of these elements that enable complicated layouts to be achieved in a professional manner. 

 

 

 In this tutorial, learn how to: 
 Adjust margins 

 Resize, move, align, nudge, and delete objects 

 Insert and work with graphics in your publication 

 Wrap text around an object or graphic 

 Use ruler guides 

 Set up and work with columns 

 Create and link text boxes 

 Resize and position objects with precision 

 Add borders and color 

 Begin from scratch or work from a pre-designed template 

 Change color, font, and design schemes 
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OPENING 

PUBLISHER 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WORKING ON THE 

PUBLICATION 

 

 

 

 

 

 

 

 

 

 

 

To open Microsoft Publisher, click on the Start button and the application from the Programs 

menu.  There should also be an icon on the desktop. 

The left-hand side of the opening screen contains the task pane, from where you will select the 

type of publication you want to create.  You can choose to open one of Publisher's many pre-

designed publications and replace the text and graphics with your own information, or you can 

use a blank publication to create a publication from scratch. 

        

 

 

As the task pane is not required at the moment, click on its Close button. 
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MARGIN GUIDES 

 

 

 

 

 

INCREASING OR 

DECREASING THE 

WORK AREA 

 

 

 

 

 

 

 

 

 

 

 

 

 

CREATING A TEXT 

OBJECT 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Observe the "non-printable" blue margin guides; these appear on every page and determine 

the working area.  The content of the publication is placed within these guides to ensure a 

consistent layout.  If required, the guides can be changed, and additional ones displayed to 

form a grid. 

Note:  Before beginning a publication it may help to sketch a rough copy of the layout on 

paper - this will help you to plan where to place the layout guides. 

 

 

1. Click on Arrange on the menu bar, and then choose Layout Guides. 

2. On the Margin Guides tab, enter new 

measurements. 

3. If the publication is going to contain columns, 

click on the Grid Guides tab and add the 

appropriate number of columns under Column 

Guides. 

4. Click on OK. 

Remember, these guides do not print - they are for 

layout purposes only. 

 

 

 

 

 

Everything in a Publisher document is an individual element, whether it is a block of text, a 

graphic, or a table.  These elements are inserted into a publication using the Objects toolbar at 

the left-hand side of the screen. 

 

 

 

 

Select Objects 

Text Box 

Insert Table 

Picture Frame 

Line 

Arrow 

Oval 

Rectangle 

AutoShapes 

Design Gallery Object 

After clicking on the relevant button on the 
toolbar, the mouse is positioned in the 
document, and while holding the left-mouse 
button down, you can drag the cursor 
diagonally to create the object.  
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Text in overflow 
indicator 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESIZING OBJECTS 

 
 

 

 

 

 

 

 

 

 

 

 

MOVING AN OBJECT 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the mouse is released, the object will then be inserted, 

surrounded by re-sizing handles. 

 

Note:  Some objects present you with further options, e.g. 

the Table object will display a "Create Table" dialog box, asking you to specify the 

number of columns and rows.   

Now create the "title" of your document (in this example: "Welcome to ResNet") in a text box. 

1. Ensure the first page is selected - if not, click 1 on the page 

sorter control buttons at the foot of the screen. 

2. Select the Text box icon on the Objects toolbar and create 

the text box. 

3. Use the buttons on the Standard toolbar to set the text size, font, alignment and 

enhancements. 

 

 

If the text box is not large enough to take all the text, a "Text In Overflow" indicator is displayed 

when the box is selected. 

 

1. To fix this, rest the mouse over 

one of the text box handles, and 

when a double-headed resize 

arrow appears, click and drag to 

enlarge the box. 

Once the text box can accommodate all the text, the Text in Overflow indicator will 

disappear. 

2. Now add another text box beneath the title containing a description of the document - 

in this example:  "A Guide to ResNet Services, Regulations and Your Responsibilities". 

 

 

1. To reposition an object, click inside to select it and then 

move the mouse slowly towards the edge of the frame. 

2. When the mouse changes into a four-headed arrow, hold 

down the left mouse button and drag the whole object to 

the desired position. 
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ALIGNING OBJECTS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NUDGING OBJECTS 

 

 

DELETING OBJECTS 

 

While the move option is useful for repositioning items, the 

aligning technique arranges objects in line with each other, 

or with the margins.  

 

1. Click the first text object, and then hold down the 

SHIFT key while clicking the second one. 

Both text objects now become interconnected. 

 

 

 

2. On the menu bar, click on Arrange, followed by Align or 

Distribute. 

3. To center the selected objects horizontally with each other, 

click on Align Center. 

Note:  You can also align selected objects relative to the margin 

by first clicking on Relative to Margin Guides, and then 

choosing another option from the menu. 

 

To move an object into an exact position (i.e. one pixel at a time), click the edge of the 

object to select it, and then press the keyboard arrow keys. 

 

 

 

1. To delete an object, select it by clicking with the mouse, and then 

"right" click to display the following short-cut menu. 

2. Click on Delete Object. 

 

 

 

 

 

 

 

 

 

INSERTING 

GRAPHICS 

 

 

 

 

 

 

 

 

  

 

Publisher will import pictures in a variety of file formats (including .jpg .gif .png .cdr .bmp 

and .tif).  To see the complete list, go to the Help menu and in the Search for: box, type:  

Graphics file formats and filters. 

Try inserting a graphic onto the first page of your A5 leaflet using one of the following two 

methods. 
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CLIP ART 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PICTURE FROM A 

FILE 

 

 

1. On the Objects toolbar, click on the Picture Frame button  

  and then select Clip Art from the sub-menu.  This will 

open the Clip Art task pane. 

2. In the Search for: box, enter a word that describes the 

required picture.  (To restrict your search to specific 

collections, or to state what the results should be, click the 

arrows in the Search in: section and select or de-select the 

options as appropriate.) 

3. Click on Go. 

4. When the results of the search are fully displayed, clip on 

the desired picture to insert it in your publication. 

 

 

You can use this method to insert a graphic previously saved in a 

file. 

1. On the Objects toolbar, click on the Picture Frame button.  

   

2. From the sub-menu, choose Picture from File. 

3. In your publication, drag the mouse to create a frame to hold the picture.  When the 

mouse is released, the Insert Picture dialog box will be displayed. 

4. Navigate to the correct folder, select the file and then click on Insert. 

 

 

 

WRAPPING TEXT 

AROUND AN OBJECT 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When a picture is placed on top of 

text, the text can be made to wrap 

around the contours rather than the 

frame of the picture as in the 

following example. 

 

1. Click on the image to select it 

– this displays the picture 

toolbar. 

2. Click on the Text Wrapping button and choose one of the following options: 

Square: this wraps the text around the 

image's frame. 

Tight: will wrap the text around the 

actual image. 

Top and Bottom: the text appears at the top and bottom of the 

image only. 

Through: this wraps the text around the perimeter and inside 
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Vertical ruler line 

To move a 
ruler guide, 
hold down 
the SHIFT 
key while 
dragging with 
the mouse. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RULER GUIDES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

any open areas. 

None: the picture is completely ignored by the text. 

 

 

3. Notice the Edit Wrap Points button at the foot of the text 

wrapping options.  This places small black handles along the 

picture outline. 

When the mouse is positioned on a handle, you can then 

drag the boundary inwards or outwards to control the text 

wrapping even more. 

 

Note:  To add more handles to the boundary, hold down the CTRL key while clicking on the 

outline.  To delete handles, hold down SHIFT+CTRL and click an existing handle. 

 

In addition to the margin guides, movable horizontal and vertical ruler guides can be displayed 

to help align objects against each other.  Ruler guides are displayed in green, do not print and 

can be dragged across a page into any position. 

1. In order to use the guides, the vertical and horizontal rulers must be displayed.  If these 

are not, click on View and then on Rulers. 

2. To create a vertical guide, position the mouse pointer over the vertical ruler and wait 

until it changes into a double arrow. 

3. Hold down the left mouse button and drag into the publication. 

4. To remove a ruler guide, 

right click on it and select 

Delete Guide from the 

pop-up menu. 

(To remove all ruler 

guides, click on Arrange, 

Ruler Guides and then 

select Clear All Ruler 

Guides.) 
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WORKING ON 

DIFFERENT PAGES 

 

 

 

 

 

WORKING WITH 

COLUMNS 

 

 

 

MULTIPLE TEXT 

FRAMES 

 

 

 

SINGLE TEXT BOX 

DIVIDED INTO 

COLUMNS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LINKING TEXT 

BOXES 

 

 

 

 

 

 

 

 

 

 

 

To move between pages in a publication, simply click the relevant page 

number on the page sorter controls at the bottom left-hand side of the screen.  

(You may need to click on the scroll bar to bring the page fully into view.)  If at 

any time you need to insert extra pages in a publication, click on the Insert 

menu and choose Page.  Enter the number of pages and specify where they should be 

positioned. 

Now start working on the other pages in the publication, adding text and images where 

appropriate. 

 

 

In order to work with columns, you can either create text frames to fit columns defined by the 

layout guides, or set up multiple columns in a single text frame. 

 

 

 

1. To add more layout guides click on Arrange, Layout Guides, Grid Guides.  Under 

Column Guides, select the desired number of columns. 

2. Now create text boxes to fit the columns. 

 

1. To divide a text box into columns, 

first select the text box, then click on 

the Format menu and select Text 

Box. 

2. Select the Text Box tab and then 

click on the Columns button. 

3. Enter the number of columns and if 

necessary adjust the spacing 

measurements. 

4. Click on OK to return to the 

publication. 

 

 

 

When a text box contains more text than it can display, the Text in Overflow 

indicator appears at the bottom of the box. 

 

Instead of increasing the text box size, hidden text can be forced to continue in another part of 

the publication, e.g. in the next column or on the next page.  This is done by creating another 

text box, and then "connecting" the two. 

1. Create another text box at the desired position, and then click in the text box which 

holds the first part of the text. 

2. On the Connect Text Boxes toolbar, click on the Create Text Box Link button.   (If 

this is not displayed, click on View, Toolbars, Connect Text Boxes.) 
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PRECISE RESIZING 

AND POSITIONING 

OF AN OBJECT 

 

 

 

 

 

 

 

 

 

 

ADDING BORDERS 

AND COLORS 

 

 

 

 

 

 

 

 

 

 

 

USING A PRE-

DESIGNED 

PUBLICATION 

 

 

 

The cursor will now change to a pitcher shape when moved over the empty text box.  

(If the new text frame is on another page, first click the relevant Page Sorter Control 

marker.) 

3. Click in the new text frame to fill 

with the overflowed text. 

When you select a text box which is 

linked to another, it will display a Go to 

Next Text Box indicator at the bottom 

right-hand corner. 

4. To move to the next connected 

box, click on the arrow. 

 

Similarly, the upper left-hand corner will 

display a "Go to Previous Text Box" 

indicator to enable you to move to the 

previous connected text box. 

 

 

1. To change the exact size and position of an object, right-click on it and then choose the 

Format . . . option from the sub-menu. 

2. Choose the Size tab and enter exact dimensions to resize, scale or rotate the object.  (If 

you select the Lock aspect ration box, this will keep the Height and Width settings in 

the same proportion.) 

3. Choose the Layout tab to position the object precisely on the page, by entering specific 

measurements in the Horizontal and Vertical boxes.  (Click on the From: box arrows to 

select the part of the page from which the Horizontal and Vertical settings are 

calculated.) 

 

 

1. To add a border to an object, ensure it is selected, then right-click on it and choose the 

Format… option from the sub-menu.  

2. Select the Colors and Lines tab. 

3. In the Line section click on the Color: arrow and choose a color for the border.  Explore 

the other options in the Line: section (Dashed, Style and Weight) and observe the 

results in the Preview window before clicking on OK to implement the change. 

4. To add a color fill to an object, in the Fill: section click on the Color: arrow.  Choose one 

of the palette colors, or experiment with the More Color and Fill Effects options.   

5. View the results in the Preview window before clicking on OK to apply the change. 

 

Instead of creating a document from scratch, you can open one of Publisher's pre-designed 

publications and modify to your own requirements. 

1. After starting Publisher, in the New Publication task pane click on Publications for Print. 

2. Scroll down the list of Publications for Print, and click on items of interest to display the 

full range in the Preview window. 
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AUTOMATICALLY 

CHANGING THE 

COLOR, FONT AND 

DESIGN SCHEMES 

3. In the Preview window, click on the desired publication and when it opens save your 

file. 

The text and pictures can now be replaced with your own information.  You can also 

automatically change the color, font and design of the publication. 

 

1. In the task pane, select Color Schemes. 

2. Click on the various options to see the 

color scheme applied to the publication. 

3. To change the publication fonts, click on 

Font Schemes. 

4. Scroll up and down the list, and click to 

apply. 

5. Click on Publication Designs to see the 

range of alternative designs – choosing a 

new one will not affect any modifications 

you have already made. 

 


